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1 General Information

1.1 Overview

NotePager Pro is a sophisticated wireless messaging (paging) application.  It is capable of delivering
messages to an unlimited number of recipients (pagers, mobile phones, PIMs, etc.) and/or groups.  NotePager
Pro includes advanced features such as scheduled messages, repeating messages, pre-programmed

messages, on-call groups, ad-hoc paging, etc.  NotePager Pro supports all of the current paging (wireless
messaging) protocols (GSMAT, SMTP, SNPP, TAP, TONE, UCP, and WCTP). Messages can be sent via a
standard modem or an Internet connection. All of NotePager Pro's features are contained within an easy-to-use
and intuitive graphical interface.

1.2 Features & Capabilities

Multiple Protocol Support - all the standard wireless messaging protocols are supported: (GSMAT, SMTP,
SNPP, TAP (IXO/PET), TONE, UCP, WCTP)

Scheduled messages  - messages can be scheduled to be sent at a future date/time

Repeating messages  - messages can be scheduled to repeat at predefined interval, for a settable period of

time

Group paging - messages can be sent to a predefined group of recipients

Multiple recipients  - allows a single message to be sent to more than one recipient and/or  group

Pre-programmed messages  - on each workstation, up to 100 pre-programmed messages can be defined

Real-time message status logs - each workstation can track the progress of each message from start to finish

Real-time message status counters - displays current number of messages scheduled, pending, sent, or
failed from each workstation

Message history log - displays a history of all messages sent from each workstation

Intelligent message queuing - messages for the same carrier are grouped together and sent during a single

communications session

Point and click operation - an intuitive user interface makes the NotePager Pro very easy to use

Spell check  - a spell check option is available on systems running MS Word

Message splitting - Long messages are intelligently split into multiple smaller messages

Settable character limits - The maximum number of characters to be sent in a message is settable by carrier
and individual recipient

On-call groups - A schedule can be setup for the recipients in a group, allowing NotePager Pro to send

messages to only the recipients scheduled to receive messages a that point in time.

Message logging - NotePager Pro keeps a detailed log of the communication sessions with the paging
carriers.

Reliapage - provides a way for recipients to be aware that a message has been missed.
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Requeue messages  - missed messages can be requeued for re-transmission to the paging carrier

Reporting - extensive reporting capabilities, including writing reports to text file

Security - three levels of password protection

Wizards  - four different wizards that make program setup a snap

Import/Export - import and export support for other NotePage products and other file formats

User-Definable fields - extra data fields can be used with each recipient for informational or filtering purposes

1.3 Shareware Information

NotePager Pro defaults into an evaluation mode until it is registered (purchased). Registration information can
be entered into NotePager Pro by choosing 'Registration' from its 'Help' menu.  The evaluation version of
NotePager Pro will stop running after 30 days of use.

Shareware is based on the try it before you buy it concept. This software is not free. You may try it. If you like the
software and would like a complete registered version you must contact sales@notepager.com. The
registration fee allows us to continue to develop quality products, notify you of updates, and provide technical

support. NotePage, Inc. accepts credit cards (Visa, MasterCard, Discover & American Express), Purchase
Orders, checks drawn on US banks, and wire transfers. If you have any questions or concerns regarding
registration please contact sales@notepager.com. If you use any of NotePage, Inc.'s software and do not
register after the trial period it is considered software piracy and is illegal.
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1.4 Purchasing

NotePager Pro can be ordered directly from NotePage, Inc:

NotePage, Inc.
PO Box 296
Hanover, MA 02339

Phone (781) 829-0500
Fax (781) 582-1869

Accepted Payment forms are:

Pre-payment
COD Company Check (continental US only)
American Express
Discover

MasterCard
Visa
Purchase Orders (continental US only)

All payments are in US Dollars

NotePager Pro can be ordered on-line at:

www.notepage.net/purchase.htm
www.notepager.com/purchase.htm
www.notepager.net/purchase.htm

Accepted Payment forms are:
American Express
Discover

MasterCard
Visa

NotePager Pro can be purchased through a NotePage authorized reseller, who can also be contracted for the

installation of our products.  Please contact us for a reseller in your area.

1.5 Contact Information

NotePage, Inc.
PO Box 296
Hanover, MA  02339
USA

Mailing Address
PO Box 296
Hanover, MA  02339

web www.notepager.com

email sales@notepager.com

phone (781) 829-0500



General Information 8

© 2001-2003 NotePage, Inc.

fax (781) 582-1869

1.6 Version Information

NotePager Pro Help File

For NotePager Pro version 3.0

Copyright 2001-2003 NotePage, Inc.

All rights reserved.

1.7 End User License Agreement

END-USER LICENSE AGREEMENT for NotePager Pro

IMPORTANT PLEASE READ THE TERMS AND CONDITIONS OF THIS LICENSE AGREEMENT CAREFULLY
BEFORE CONTINUING WITH THIS PROGRAM INSTALL:
NotePage, Inc.'s End-User License Agreement ("EULA") is a legal agreement between you (either an individual
or a single entity) and NotePage, Inc. for the NotePage software product(s) identified above which may include

associated software components, media, printed materials, and "online" or electronic documentation
("SOFTWARE PRODUCT"). By installing, copying, or otherwise using the SOFTWARE PRODUCT, you agree to
be bound by the terms of this EULA. This license agreement represents the entire agreement concerning the
program between you and NotePage, Inc., (referred to as "licensor"), and it supersedes any prior proposal,

representation, or understanding between the parties.  If you do not agree to the terms of this EULA, do not
install or use the SOFTWARE PRODUCT.

The SOFTWARE PRODUCT is protected by copyright laws and international copyright treaties, as well as other

intellectual property laws and treaties. The SOFTWARE PRODUCT is licensed, not sold.

1. GRANT OF LICENSE.  The SOFTWARE PRODUCT is licensed as follows:
(a) Installation and Use. NotePage, Inc. grants you the right to install and use copies of the SOFTWARE

PRODUCT on your computer running a validly licensed copy of the operating system for which the SOFTWARE
PRODUCT was designed [e.g., Windows 95®, Windows 98®, Windows ME®, Windows NT®, Windows 2000®,
Windows XP®].
(b) Per Computer License. Ownership of The SOFTWARE PRODUCT only permits for The SOFTWARE

PRODUCT to be installed on a SINGLE computer. Ownership of The SOFTWARE PRODUCT only permits for a
SINGLE instance of The SOFTWARE PRODUCT to be run said computer. For use of The SOFTWARE
PRODUCT on additional computers, or for use of more than one instance of The SOFTWARE PRODUCT on a
single computer, additional licenses MUST be purchased.

(c) Backup Copies. You may also make copies of the SOFTWARE PRODUCT as may be necessary for backup
and archival purposes.

2. DESCRIPTION OF OTHER RIGHTS AND LIMITATIONS.

(a) Maintenance of Copyright Notices.  You must not remove or alter any copyright notices on any and all copies
of the SOFTWARE PRODUCT.
(b) Distribution. You may not distribute registered copies of the SOFTWARE PRODUCT to third parties.
Evaluation versions available for download from NotePage, Inc.'s websites may be freely distributed.

(c) Prohibition on Reverse Engineering, Decompilation, and Disassembly. You may not reverse engineer,
decompile, or disassemble the SOFTWARE PRODUCT, except and only to the extent that such activity is
expressly permitted by applicable law notwithstanding this limitation.
(d)  Rental. You may not rent, lease, or lend the SOFTWARE PRODUCT.

(e) Support Services. NotePage, Inc. may provide you with support services related to the SOFTWARE
PRODUCT ("Support Services").  Any supplemental software code provided to you as part of the Support
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Services shall be considered part of the SOFTWARE PRODUCT and subject to the terms and conditions of this
EULA.
(f) Compliance with Applicable Laws. You must comply with all applicable laws regarding use of the

SOFTWARE PRODUCT.

3. TERMINATION
Without prejudice to any other rights, NotePage may terminate this EULA if you fail to comply with the terms and

conditions of this EULA. In such event, you must destroy all copies of the SOFTWARE PRODUCT in your
possession.

4. COPYRIGHT

All title, including but not limited to copyrights, in and to the SOFTWARE PRODUCT and any copies thereof are
owned by NotePage, Inc. or its suppliers. All title and intellectual property rights in and to the content which may
be accessed through use of the SOFTWARE PRODUCT is the property of the respective content owner and
may be protected by applicable copyright or other intellectual property laws and treaties.  This EULA grants you

no rights to use such content.  All rights not expressly granted are reserved by NotePage.

5. NO WARRANTIES
NotePage, Inc. expressly disclaims any warranty for the SOFTWARE  PRODUCT. The SOFTWARE PRODUCT

is provided "As Is" without any express or implied warranty of any kind, including but not limited to any
warranties of merchantability, noninfringement, or fitness of a particular purpose. NotePage does not warrant
or assume responsibility for the accuracy or completeness of any information, text, graphics, links or other
items contained within the SOFTWARE PRODUCT.  NotePage makes no warranties respecting any harm that

may be caused by the transmission of a computer virus, worm, time bomb, logic bomb, or other such computer
program. NotePage further expressly disclaims any warranty or representation to Authorized Users or to any
third party.

6. LIMITATION OF LIABILITY
In no event shall NotePage, Inc. be liable for any damages (including, without limitation, lost profits, business
interruption, or lost information) rising out of 'Authorized Users' use of or inability to use the SOFTWARE
PRODUCT, even if NotePage, Inc. has been advised of the possibility of such damages.  In no event will

NotePage be liable for loss of data or for indirect, special, incidental, consequential (including lost profit), or
other damages based in contract, tort or otherwise. NotePage, Inc. shall have no liability with respect to the
content of the SOFTWARE PRODUCT or any part thereof, including but not limited to errors or omissions
contained therein, libel, infringements of rights of publicity, privacy, trademark rights, business interruption,

personal injury, loss of privacy, moral rights or the disclosure of confidential information.
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2 Installation

2.1 System Requirements

Minimum requirements to run the NotePager Pro:

Operating System:  Windows 95, 98, ME, NT, 2000, XP

Processor:  Pentium

Memory:  16 Meg of free memory (typically 64 Meg for Windows 95/98/ME, 128 for Windows NT/2000/XP, on a

bare system)

Storage:  50 Meg of free disk space

Communications:  300 baud or faster modem, or an active Internet connection.

2.2 Installation Instructions

2.2.1 CD-Rom Installation

1.  Insert the NotePager Pro CD-Rom into your computer.

2.  NotePager Pro's setup routine will (on most computers) automatically start.  If the setup program starts, go

to step 3 below.  If not, click on the Windows start button, and then choose 'Run' from the menu.  Type in
'd:\setup' without the quotes (in this example the CD-Rom drive letter is 'd'. If your CD-Rom drive letter is
different, use it instead).  Next hit the 'OK' button.

3.  After some temporary setup files are extracted, the initial setup screen will be displayed.  Choose 'Install
NotePager Pro' to continue the setup.

4.  Next, a welcome screen will be displayed.  After reading the welcome information, click 'Next' to continue.

5.  The next setup screen will give you the option to review NotePager Pro's ReadMe and Release Notes files.
If you choose to display either file, they will be shown when you hit the 'Next' button.

6.  The following screen will display NotePager Pro's End User License Agreement.  Please read it carefully
and proceed with the installation of NotePager Pro ONLY if you agree with ALL the terms of this agreement.

7.  On the next screen you can specify a location where you want NotePager Pro installed.  The default install

location is C:\Program Files\NotePager Pro\. You can change the installation path by hitting the 'Browse'
button.  To accept the install location, hit 'Next'.

8.  You will now be prompted for the name of the group that the NotePager Pro icons should be added to in the

Windows Start Menu.  The default group is 'NotePager Pro'.

9.  The setup program is now ready to install NotePager Pro.  Click on the 'Next' button to start the installation
process.

10.  The setup program will now copy the NotePager Pro program and support files to your computer.

11.  The next screen will tell you that NotePager Pro has been successfully installed.  Hit the 'Finish' button to

exit NotePager Pro's setup program.

12.  In some cases, your computer will ask to be restarted after the installation of NotePager Pro.  If you are
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prompted to do so, you must restart your computer before running NotePager Pro.

2.2.2 Single executable (.exe) installation

1.  Run the executable file that you downloaded (nppv3.exe).

2.  After some temporary setup files are extracted, the initial setup screen will be displayed.  Choose 'Install
NotePager Pro' to continue the setup.

3.  Next, a welcome screen will be displayed.  After reading the welcome information, click 'Next' to continue.

4.  The next setup screen will give you the option to review NotePager Pro's ReadMe and Release Notes files.
If you choose to display either file, they will be shown when you hit the 'Next' button.

5.  The following screen will display NotePager Pro's End User License Agreement.  Please read it carefully
and proceed with the installation of NotePager Pro ONLY if you agree with ALL the terms of this agreement.

6.  On the next screen you can specify a location where you want NotePager Pro installed.  The default install
location is C:\Program Files\NotePager Pro\. You can change the installation path by hitting the 'Browse'
button.  To accept the install location, hit 'Next'.

7.  You will now be prompted for the name of the group that the NotePager Pro icons should be added to in the
Windows Start Menu.  The default group is 'NotePager Pro'.

8.  The setup program is now ready to install NotePager Pro.  Click on the 'Next' button to start the installation

process.

9.  The setup program will now copy the NotePager Pro program and support files to your computer.

10.  The next screen will tell you that NotePager Pro has been successfully installed.  Hit the 'Finish' button to
exit NotePager Pro's setup program.

11.  In some cases, your computer will ask to be restarted after the installation of NotePager Pro.  If you are

prompted to do so, you must restart your computer before running NotePager Pro.

2.2.3 Single archive (.zip) installation

1.  To extract the NotePager Pro installation file from the archive (.zip) file, you will need a program such as
WinZip or PKZip.  Extract the contents of the .zip file that you have downloaded (nppv1.zip) into a temporary

directory by using one of these utilities.

2.  Run the file named nppv1.exe from the location where you extracted NotePager Pro's installation file.

3.  After some temporary setup files are extracted, the initial setup screen will be displayed.  Choose 'Install
NotePager Pro' to continue the setup.

4.  Next, a welcome screen will be displayed.  After reading the welcome information, click 'Next' to continue.

5.  The next setup screen will give you the option to review NotePager Pro's ReadMe and Release Notes files.
If you choose to display either file, they will be shown when you hit the 'Next' button.

6.  The following screen will display NotePager Pro's End User License Agreement.  Please read it carefully
and proceed with the installation of NotePager Pro ONLY if you agree with ALL the terms of this agreement.
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7.  On the next screen you can specify a location where you want NotePager Pro installed.  The default install
location is C:\Program Files\NotePager Pro\. You can change the installation path by hitting the 'Browse'
button.  To accept the install location, hit 'Next'.

8.  You will now be prompted for the name of the group that the NotePager Pro icons should be added to in the
Windows Start Menu.  The default group is 'NotePager Pro'.

9.  The setup program is now ready to install NotePager Pro.  Click on the 'Next' button to start the installation
process.

10.  The setup program will now copy the NotePager Pro program and support files to your computer.

11.  The next screen will tell you that NotePager Pro has been successfully installed.  Hit the 'Finish' button to
exit NotePager Pro's setup program.

12.  In some cases, your computer will ask to be restarted after the installation of NotePager Pro.  If you are
prompted to do so, you must restart your computer before running NotePager Pro.

2.2.4 Post-Installation

1.  If you installed from CD-Rom, remove the CD and keep it in a safe place.  You will need it again if you ever
need to reinstall NotePager Pro.

2.  If you installed the NotePager Pro from a single downloaded file (nppv1.exe or nppv1.zip), be sure to make a

copy of the file and store it in a safe place. You will need it again if you ever need to reinstall NotePager Pro.

2.2.5 Installation Troubleshooting

Problem:  Any number of different problems
Solution:  Be sure that there are no other programs running when you install the NotePager Pro.  There may be
programs running even if you don't see them in your task bar.  Pressing <ctrl><alt><del> will bring up a list of

running programs in Windows 95, 98, or ME.  In Windows NT, 2000, or XP you can choose 'Task Manager' after
hitting <ctrl><alt><del> for similar information.  Stop any program that you believe is causing the conflict.
WARNING: this should only be done by an experienced user.  Randomly ending tasks can lock up your
computer, lose data or worse.  Please consult with and experienced technician before killing any processes.  A

clean reboot can sometimes also help.  Holding down the shift key while windows is starting will stop some
programs from starting that normally load at startup.  Try re-running the NotePager Pro setup program.



Operation



NotePager Pro v3.015

© 2001-2003 NotePage, Inc .

3 Operation

3.1 First Time Setup

These instructions will walk you through the necessary steps to send your first message:

The easiest way to get up-and-running quickly is to use NotePager Pro's wizards.  The wizards can be started

by choosing 'Wizards' from the 'Tools' menu.  Starting with the 'Setup' wizard will walk you through everything
you need to setup your first wireless device (pager, phone, PIM, etc.)

3.2 Sending a Message

Sending a message is as easy as 1, 2, 3.

1. Choose a recipient(s) from the 'Recipient List'. Selected recipients will move to the 'Selected Recipients' list.

2. Enter a message in the 'Message Text' box.

3. Hit the 'SEND' button.

DONE !!!

3.3 Shortcuts, Hints, and Things You Should Know

The 'Clear' button next to the 'Selected Recipients' list will clear all the selected recipients

The 'Clear' button next to the 'Message Text' box will clear the entire message text

Clicking on the 'Prog1' - 'Prog5' buttons will automatically type pre-programmed messages into the 'Message
Text' area.

Right-clicking on the 'Prog1' - 'Prog5' buttons will allow you to set or modify the pre-programmed message for

that button.

Clicking on the 'Sched', 'Pend', 'Sent', or 'Bad' numbers (or labels) will bring up its respective status log.

If you have spell checking enabled, double-clicking anywhere in the 'Message Text' area will start the spell
check.

If the 'Recipient List' has the focus (is the current window), you can type the first few characters of a recipient's

name to jump directly to that recipient.  The <ENTER> key can then be used to select that recipient.  The
'Recipient List' get the focus after a recipient is selected, or if you right-click anywhere in the 'Recipient List'
window.

The 'OPTIONS' button allows you to schedule messages to be sent in the future or to schedule repeating
messages.

Clicking on the blue 'NotePager Pro' logo will bring up the 'About' information screen.

3.4 Keyboard Shortcuts

Abort All Messages Ctrl-A
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Send Message Alt-Enter or Ctrl-S

Erase Recipients and Message Ctrl-E

Set Focus to Recipient List Ctrl-R

Set Focus to Message Text Ctrl-T

Show All Preset Message Ctrl-P

Preset Message (1-9) Ctrl-(1-9)

Filter Recipients Ctrl-F

3.5 Mouse Shortcuts

Abort All Messages Right-Click on Pend

View Scheduled Messages Click on Sched

View Pending Messages Click on Pend

View Sent Messages Click on Sent

View Bad Messages Click on Bad

Program Preset Message Right-Click on Prog1-Prog5

Filter Recipient List Right-Click on Recipient List

Show Recipient Details Shift-Click on Recipient

Show Group Details Shift-Click on Group

Spell Check Message Double-Click on Message Text

Set Focus to Recipient List Click on Recipients Heading

Autoscroll Monitor Log Right-Click in Connection Monitor

3.6 Minimizing NotePager Pro

The NotePager Pro application can be minimized to remove its window from the Windows desktop, but to keep
it running for instant access.  When the NotePager Pro is minimized, it will either appear as a pager in the
Windows system tray (bottom right corner next to the clock), or as a button in the Windows task bar (just like

regular programs).  To restore the NotePager Pro's window, simply click on the pager icon in the Windows
system tray, or on the button in the Windows task bar.

The setting that changes the behavior of the minimize function is found on the 'Display' screen under the 'Tools'

-> 'Settings' menu.
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3.7 Quitting

You can quit the NotePager Pro by choosing 'Exit' from the 'File' menu, clicking on the 'X' control in the
NotePager Pro's top right corner, or by double-clicking on the pager icon in the NotePager Pro's top left corner.

Many users find it useful to keep the NotePager Pro running at all times, and simply keep it minimized for quick
access.
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4 Reference

4.1 Ad-Hoc

Ad-Hoc messages are messages that are sent to a recipient that isn't actually setup in NotePager Pro.  By
using Ad-Hoc, messages can be sent to a recipient by choosing the recipient's paging carrier (by choosing the
carrier's ad-hoc recipient that must already be setup in NotePager Pro) and providing the ID/PIN number for the

recipient's pager (or other wireless messaging device).  Ad-Hoc recipients that have been setup in NotePager
Pro will show up at the beginning of the 'Recipient List' and will have the text '(A)' before their name.  If you
choose an Ad-Hoc recipient, you will be prompted for the recipient's ID/PIN number before the entry is moved
into the 'Selected Recipients List'.

4.2 Bad

The 'Bad' status number on the main NotePager Pro screen shows how many messages produced errors
when being delivered.  These messages were not successfully sent to the recipient's pager.  By clicking on the
'Bad' label, you can bring up the full 'Bad Messages' log.  See 'Bad Messages' for more information about this

log.

4.3 Bad Messages

The 'Bad Messages' log shows information about messages that have received errors while being delivered.
Information is only shown for messages sent during the current session of the NotePager Pro.  This log
displays whom the message was sent to, when it was entered, the current message status, and the beginning

of the actual message.  The 'Refresh' button will update the displayed information.  The 'Requeue' button will
change the highlighted message's status from 'bad' back to 'pending' (the message will be resent).  The
'Close' button will close the log screen.  The 'Bad Messages' log can be accessed by choosing 'Bad' form the
'View' menu, or by clicking on the 'Bad' label on the NotePager Pro's main screen.

4.4 Carrier

A carrier is a company that provides the service for a wireless device (pager, phone, PIM, etc.).  They control the
antennas, satellites, broadcast, and computer systems that are used to send the messages to your pager.
You may purchase your service from a reseller who represents several different carriers.  They resell the
paging service, but are not actually the carrier.  When setting up NotePager Pro, you will need some information

about the actual carrier that your wireless device is serviced by (see the installation part of the documentation
for specifics).

4.5 Characters

NotePager Pro has a character counter that displays on the main screen.  It updates itself as a message is
typed into the 'Message Text' area.  This number in not necessarily the exact number of characters sent out in
the actual message.  The sender's name may be added to the beginning of each message depending on
settings for each recipient.  Also,  options such as 'Reliapage' add more information to the message before it is

sent out.  The maximum number of characters that the message box will accept can be set by going to 'Tools' -
> 'Settings' -> 'Display'.

4.6 Clear

Two 'Clear' buttons appear on NotePager Pro's main screen.  The 'Clear' button immediately to the right of the

'Selected Recipients' list, clears all the selected recipients.  The 'Clear' button immediately to the right of the



Reference 20

© 2001-2003 NotePage, Inc.

'Message Text' box, clears any text in its box.

4.7 Clear on Send

If the 'Clear on send' setting in NotePager Pro's setup screen is enabled, whenever a message is sent by the
user, the 'Selected Recipients' list and the 'Message Text' box will be automatically cleared.  Otherwise, these

two display boxes are left in their previous state, when a message is sent.

4.8 Connection Monitor

The Connection Monitor shows you, in real time, the communication session between NotePager Pro and the
wireless carriers.  This is especially helpful when first setting up and testing new carriers and recipients.  This

same information can be viewed after-the-fact in the dialer log file.  The log can be view by choosing 'Dialer Log'
from the 'View' menu.

If you close the Connection Monitor, it can be displayed again by choosing 'Connection Monitor' from the 'View'

menu.

Right-clicking in the log area of the Connection Monitor will toggle 'autoscroll' on and off.  When autoscroll is on,
the Connection Monitor's log will automatically scroll so the most current information is always showing.

4.9 Copy

A message that is scheduled, pending, or has already been sent, can be copied back onto NotePager Pro's
main screen so it can be modified and re-sent.  This option is available from the scheduled, pending, sent, bad

and history logs (available from the view menu).

4.10 Display Options

The Display Options setup screen  is accessible  from 'Settings' option under the 'Tools' menu.  These settings
control how some of NotePager Pro's information is displayed.  Also, some of these settings allow you to

disable a few of NotePager Pro's features.  This can be useful if a simplified user interface is desired for end
users.

Comment Label: Each recipient or group has two user-defined fields associated with them.  By default these

fields are labeled 'Comment1' and 'Comment2'.  You can change these labels to something more meaningful.

Max Msg Length: The number of characters that the message box on the main screen can be limited by
changing this value.

Remove Preset Buttons:  This option will remove the programmable message buttons on the NotePager Pro
window.

Remove Option button:  This option will remove the 'Options' button from the NotePager Pro window.  This will
remove the end user's ability to send scheduled and repeating messages.

Remove Logs: This option will prevent the user from being able to view NotePager Pro's log files.

Remove Reports: This option will prevent the user from being able to view or print reports.

Small Recipient Font: This option will use a smaller font in the 'Recipient List' and 'Selected Recipients'

listboxes.

Failure Warning Popup: This option will cause NotePager Pro to display a large red failure warning box if a
message can't be delivered.
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Clear on Send: When this option is checked, the list of selected recipients and the message text will be
automatically cleared each time a message is sent.

Display group label: Groups are distinguished from regular recipients in the Recipient list by being prefixed
with the letters '(G)'.  If desired, this label can be moved to the end of the group's name.

Minimize To: When NotePager Pro's main screen is minimized, it can do one of two things.  It can either put an

icon in the Windows system tray, or it can minimize to the Windows task bar.

4.11 Enable Spell Check

The 'Enable Spell Check' checkbox is used to enable/disable the message spell checking option.  The
NotePager Pro can use Microsoft Word's spell checking dictionary.  MS Word 97 or newer is required.  The

'Enable Spell Check' setting is located on the 'General Settings' screen found under the 'Tools' -> 'Settings'
menu.

4.12 Exporting

NotePager Pro can export information from several different destinations:

NotePager Pro - There is no need to export information between versions of NotePager Pro.  Any database
from an earlier version will be automatically upgraded if this version is installed to the same folder as the
previous version

NotePager Net - Many companies upgrade from NotePager Pro to NotePager Net (a client/server network
version of NotePager Pro).  This option makes moving your existing settings into the network version easy.

PageGate - Many companies upgrade from NotePager Pro to PageGate (a wireless messaging server with

many interfaces and features).  This option makes moving your existing settings into PageGate easy.

WebGate - Many companies upgrade from NotePager Pro to WebGate (a wireless messaging server with
Internet gateways).  This option makes moving your existing settings into WebGate easy.

Text File - NotePager Pro can write its settings out standard comma delimitated text files.

4.13 Filtering (Searching)

The 'Recipient List' on NotePager Pro's man screen can be filtered to only display a small group (or single) of
recipients.  This is very helpful if you have a long recipient list.  Filtering can also be used to find recipients that
match the user-defined fields that are associated with each recipient and group.

To filter the Recipient List, simply right-click somewhere in the Recipient list, and then enter information in the
window that pops up that you want the recipients to meet.  Leave all the fields blank to remove any active filter
and display the full recipient list again.

4.14 General Settings

The 'General Settings' contains general program setting.

The 'Sender's Name' field allows you to set the name of the operator of this workstation.  Each message sent

by NotePager Pro is prefixed with the name of the sender. You can set the sender's name to %LoginName% to
have NotePager Pro automatically use the currently logged in username for the sender.

The 'Max Log Length' field sets the maximum length that the dialer log will grow to (in bytes).
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The 'Purge After' setting is used to set how long message history will be kept in the NotePager Pro database
file.

The 'Detailed Log' setting enabled (or disables) the logging of detailed communications information in the
dialer log.

The 'Archive Log' option, when enabled, renames each day's dialer log with the date.  This is used if you need

to keep a log of all messages sent out each day.

The 'Enable Spell Check' checkbox allows you to enable the spell checking option in the NotePager Pro.  In
order to use this option, you must have Microsoft Word 97 or newer installed on your system.

The above settings can be saved so that all users of this workstation will use these settings, or so that only the
currently logged in user uses these settings.  This applies to most of the other settings screens too.

4.15 Groups

Messages can be sent to a pre-defined group of recipients.  Groups will show up at the beginning of the
'Recipient List' and will have the text '(G)' before their names.  When you send a message to a group, the
message will be delivered to all the members of the group.

4.16 History

The 'History' shows information about all messages sent from this workstation.  You have options of printing
the log to a printer, or copying the log to your computer's clipboard for use in another application.  Messages

can also be requeued and copied from the history screen.

4.17 Importing

NotePager Pro can import information from several different sources:

NotePager32 - You would use this if you are upgrading from NotePager32 to NotePager Pro

NotePager Pro - There is no need to import from previous versions of NotePager Pro.  Any database from an
earlier version will be automatically upgraded if this version is installed to the same folder as the previous

version

NotePager Net - It is common for companies that are using NotePager Net to use NotePager Pro on their
portable computers, when not connected to the company's network.  Importing the settings from NotePager Net

into NotePager Pro will keep the portable computers up-to-date.

PageGate - It is common for companies that are using PageGate to use NotePager Pro on their portable
computers, when not connected to the company's network.  Importing the settings from PageGate into

NotePager Pro will keep the portable computers up-to-date.

WebGate - WebGate's settings can also be imported into NotePager Pro.  This would mainly be used on
portable computers that will not have Internet access to the WebGate supported webpages.

Text File - NotePager Pro can import settings from standard comma delimitated text files.  This enables
NotePager Pro to accept information from other applications or data sources.
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4.18 InitStrings

What is an init string?
Different modems can't necessarily talk to each other as set right out of the box.  Modems use many different

settings and protocols.  In order for two modems to communicate, they must agree on many things such as
speed, error correction, compression algorithms, etc...  By sending a modem an init string, you can control
some of these parameters.

What do I need to put in my init string?
In general, the modems used by paging carriers run at a speed from 300 to 2400 baud (1200 being the most
common).  They don't typically use any form of error correction or data compression protocols.  In many cases,
if your modem tries to use either of these protocols, your modem will be unable to communicate with the

paging terminal's modem.  In your init string you should include settings to lock you modem's baud rate to that
of your carrier's modem, disable error correction protocols, and disable data compression protocols.  In
addition NotePager Pro would like your modem to issue English response codes (rather than numeric
response codes), and issue complete connection information.

Do all modems use the same init string?
No, many different modem manufacturers use their own set of modem commands.  Init strings may even be
different between models by the same manufacturer.

My init string works on one carrier but not the other.
You may need a different init string to connect to each carrier.  In general your init strings will be the same, but
not always.

What init string should I use?
There is no easy answer to this.  In general, if your modem is a 2400 baud model or slower (very old models)
you won't need an init string.  These older modems sometimes work best when communicating with the

paging terminals.  Anything faster (9600, 14.4, 28.8, 33.6, 56K, etc.), will probably require an init string.  Some of
the most common init strings are listed below.  If you have a less well known brand modem, you may need to
use the documentation include with you modem to create an init string.

Common Init Strings

AT&FQ0V1X4&D2   - Minimal settings.  Works with most 1200 and 2400 baud modems. Some modems use
&F0 rather than &F.  All '0' are zeros not oh's.

AT&FQ0V1X4&D2N0S37=5   - Hard coded baud rate.  Works with many 14.4 and 28.8 modems.  The added
codes locks the connection baud rate to 1200 baud.  Use S37=3 for a 300 baud connection, and S37=6 for a
2400 baud connection.  Some modems use &F0 rather than &F.  All '0' are zeros not oh's.

AT&FQ0V1X4&D2N0S37=5\N0%C0   - No compression/error correction.  Works with many 14.4, 28.8 and 33.6
modems.  The added codes turn off data compression and error correction.  You can try using only one of the
two additional codes (\N0 or %C0) if you modem rejects using both.  Use S37=3 for a 300 baud connection,

and S37=6 for a 2400 baud connection.  Some modems use &F0 rather than &F.  All '0' are zeros not oh's.

AT&F0Q0V1X4&D2&B1&K0&M0&N2   - US Robotics (3Com) string.  Works with most US Robotics/3Com 33.6
and 56K modems (and some others too).  Use &N1 (instead of &N2) for a 300 baud connection, or &N3 for a

2400 baud connection.

AT&FQ0V1X4&D2N0+MS=B103  - This string has been found to work with some of the newer winmodems.  Set
the baud rate to 300 when using this string.

Note: all '0' characters in the init strings are zeros not oh's

***More init strings may be available on our web site: www.notepager.com
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4.19 Message Content

Messages sent by NotePager Pro are sent with more information than just the message itself.  Messages will
be prefixed with the reliapage index (if enabled), the block number (if it is part of a large message that has been

broken into smaller pieces.  i.e. 1 of 3, 2 of 3, 3 of 3), the sender's name (optional), and then the message
itself.  Each of these fields is separated with a colon (:).  Most pagers have a limited character set usually
consisting of upper and lower case letters, numbers, and some symbols (periods, commas, dollar signs,
exclamation points, etc.).  Non printing characters such as carriage returns, line feeds, tabs, and some

symbols are not commonly supported.  By default the NotePager Pro Server will strip all non-printable
characters from the messages.  Non-printable characters can be sent as part of the message by unchecking
the 'Drop non-printable characters' option on the recipient's setup screen.

4.20 Message Text

The 'Message Text' area is where the actual message to be sent is typed.  Commonly used messages can be
automatically entered by hitting one of the 'Prog1' - 'Prog5' buttons (see 'Presets' for information on settings and
use of these buttons).  A character counter is displayed above the 'Message Text' area.  If spell checking is
enabled (see 'Spell Checking'), it can be invoked by double-clicking anywhere in the 'Message Text' area.

4.21 Modem Settings

The 'Modem Settings' screen allows you to change settings that control how NotePager Pro uses your modem.

The 'Modem Port' field is used to set the serial port that your modem is attached to.

The 'Dialing Prefix' field is used if the phone line your modem is using requires a code to be dialed to get an
'outside' dialtone.  The most common setting for this (other than leaving it blank) would be: 9,

The 'Retries' field sets the number of times a failed message should be retried before the message is

permanently marked as bad.

The 'Retry Interval' field sets how long NotePager Pro should pause (in seconds) between retries.

4.22 Notify Only

Recipients in NotePager Pro can be set to 'Notify Only'.  When this option is enabled, a predefined (settable)

message (notification code) is sent instead of the actual message.  This is most often used with numeric
pagers.

4.23 Numeric Pagers

Some pagers are only capable of displaying numbers (no letters).  These are commonly called numeric or
digital pagers (beepers).  NotePager Pro fully supports numeric pagers.  If a message is sent to a numeric
pager, and the message contains letters, the recipient's notification code (999 by default) is sent instead.  This

alerts the recipient that they have been sent a message that was alphanumeric in nature, and they should take
steps to retrieve the actual message.

4.24 Options

The 'Options' button brings you to the 'Advanced Message Options' screen.  From here, scheduled and
repeating messages can be setup.  To schedule a page to be sent at a future date and time, fill in the 'Send
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Message When' fields.  To schedule a message to be sent repeatedly, fill in the 'Send Message When' fields
for when you want the first page to be sent.  Fill in the 'Resend Messages Every' fields to set the interval at
which the message is to be repeated.  Finally, fill in the 'Stop Sending Message' fields to set the date and time

for the message to stop being sent.

4.25 On-Call Groups

NotePager Pro has a feature built into it that can be very useful in an on-call service environment.  After
recipients are added to a group, a schedule of recipients can be setup defining when each recipient is on-call
(starting day and time, and ending day and time).  When a message is sent to the group, the schedule is

consulted to see which recipient or recipients the message should be sent to.  This way, only the recipients
that are scheduled to be on-call receive the page.

4.26 Pager (Beeper)

Throughout NotePager Pro's documentation the word 'pager' is used.  'Pager' is better defined as 'wireless
messaging device'.  NotePager Pro can be used to send messages to many devices other than pagers.  For
example messages can be sent to digital/cellular/mobile/pcs phones, pager cards for portable computers,

Personal Information Managers (PIMs), billboards, and many other wireless messaging devices.

4.27 Passwords

The 'Password Setup' screen is accessed by choosing 'Tools' -> 'Settings' -> 'Passwords' from NotePager
Pro's menu.

Admin Password - If you set an Admin Password, users will be required to enter it to access any of the setup
screens.  The Admin Password will also work in place of either of the other two passwords.

Super User Password - If you set a Super User Password, users will be required to enter it to access the

carrier, recipient, and group setup screens.  The Super User Password will also work in place of the User
Password.

User Password - If you set a User Password, users will be required to enter it in order to start the NotePager

Pro program.

4.28 Pend

The 'Pend' status number on the main NotePager Pro screen shows how many messages are still waiting to
be sent by NotePager Pro.  By clicking on the 'Pend' label, you can bring up the full 'Pending Messages' log.

See 'Pending Messages' for more information about this log.

4.29 Pending Messages

The 'Pending Messages' log shows information about messages that are waiting to be sent by NotePager Pro.
This log displays whom the message was sent to, when it was sent to the paging server, the current message
status, and the beginning of the actual message.  The 'Refresh' button will update the displayed information.

The 'Cancel' button will cancel the highlighted message.  The 'Edit' button will allow you to temporarily suspend
the message, make changes to it, and then re-send it.  The 'Copy' button will copy the message information
back into the main NotePager Pro screen (without affecting the currently pending message).  The 'Close' button
will close the log screen.  The 'Pending Messages' log can be accessed by choosing 'Pending' form the 'View'
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menu, or by clicking on the 'Pend' label on NotePager Pro's main screen.

4.30 Pre-programmed Messages

Up to one hundred frequently used messages can be pre-programmed for your convenience.  The first five of
these can accessed with a single click on the main screen. These messages can be automatically inserted

into the 'Message Text' area by clicking on the 'Prog1' - 'Prog5' buttons.  The rest of the pre-programmed
message are accessed by clicking on the 'More' button.  The first five pre-programmed messages can be set
by right-clicking on its button.  To bring up the 'Preset Messages' screen, which displays all the pre-
programmed messages, click on the 'More' button, or choose 'Tools' -> 'Presets' from the menu.

Each pre-programmed message can also, optionally, be assigned a recipient or group.  This option will not
only add the programmed message text to the main screen, but will also automatically select a recipient or
group to send the message to.

4.31 Protocols

NotePager Pro supports seven different protocols to deliver messages to wireless carriers.  You will need to
contact your carrier to verify what protocols they support.  You can also find protocol support information for
many carriers in the support section of our website (www.notepager.com).

GSMAT - This protocol was initially defined as part of the GSM protocol.  It uses AT Commands to communicate
with mobile phones and wireless modems that are directly connected to your computer (usually to the serial
port).  This protocol can be used to send messages totally wirelessly: from your wireless device (phone or
modem), directly to the recipients's device.

SMTP - (Simple Mail Transfer Protocol) This is the same Internet based protocol that is used for regular email.
Although most wireless carriers support this protocol, it shouldn't be your first choice.  Using SMTP can result
in delays in delivery, and there is no confirmation that the carriers has even accepted the message.

SNPP - (Simple Network Paging Protocol) This is an excellent Internet based protocol.  It has all the
advantages of TAP, but tends to be faster.

TAP - (Telocator Alphanumeric Protocol) The is probably the oldest, and most widely used modem based
wireless messaging protocol.  Previous versions of TAP were named IXO and PET.  NotePager Pro supports
all of these standards.

TONE - (Touch Tone) Although not really a protocol, touch tone delivery is still exclusively used for many
numeric pagers.

UCP - (Universal Computer Protocol) A modem-based protocol that is used mostly in Europe.

WCTP (Wireless Communications Transfer Protocol) Another Internet based wireless messaging protocol.  It's
not quite as widely accepted as SNPP.

4.32 Recipient List

The 'Recipient List' listbox is displayed on the NotePager Pro's main screen.  It lists the recipients that can be
chosen to send messages to.  Recipients are listed alphabetically by the recipient's full name.  Groups are
listed before single recipients and are prefixed with a (G) label.  Recipients are moved from the 'Recipient List'

to the 'Selected Recipients' list by clicking on the recipient's name.  You can also select recipients by typing the
first few letters in their name and hitting <ENTER>.  This only works if the 'Recipient List' is the active control
(has the focus).  Set the focus to the 'Recipient List' by clicking on the 'Recipient List' heading, or by hitting <Ctrl-
R>. Once a recipient is selected, it is moved from the 'Recipient List' box to the 'Selected Recipients' box.
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If you shift-click on a recipient or group, you can view more detailed information about that recipient or group
(including members in the case of the group).

If you right-click in the recipient list, you can filter which recipients show up in the list.

4.33 Recipients

In NotePager Pro, 'recipient' is synonymous with 'pager' (or other wireless messaging device).  A recipient is
the person who carriers the actual pager.  When NotePager Pro refers to a 'recipient' it is really referring to the
recipient's pager.  This approach simplifies things for the end users.  For example if a user were to replace

their pager with a new unit, the recipient name will stay consistent, even though the pager's information would
change.

4.34 Reliapage

As you are probably aware, traditional paging uses a one-way transmission.  There is no confirmation sent
back from the pager that messages have (or have not) been received.  In poor coverage areas, messages can

be, and are missed.  NotePager Pro's Reliapage option sequentially numbers each message sent out.  A
numbering sequence is maintained for each individual recipient.  This way, if a recipient receives messages
with a number missing, they will know that they have missed a message.  Messages for an individual or group
of recipients can be resent from the sent or history logs in NotePager Pro.

4.35 Reports

NotePager Pro can generate many useful reports.  Each report has several options of what to display and how

to display the information.  All reports can be previewed on your screen before they are printed.  Also, all reports
can be saved to a standard text file, instead of printed.

Sent Messages - These reports will show information about messages that have already been sent (both

successful and failed messages).  There are three different ways to view this information:
  By Recipient - Messages are grouped by which recipient they were sent to
  By Date/Time - Messages are listed in the order they were sent out
  By Carrier - Messages are grouped by which carrier they were sent to

Scheduled Messages - These reports show messages that have not yet been sent out.  These are typically
messages that were scheduled to be sent in the future, or messages that repeat.  There are three different
ways to view this information:

  By Recipient - Messages are grouped by which recipient they were sent to
  By Date/Time - Messages are listed in the order they were sent out
  By Carrier - Messages are grouped by which carrier they were sent to

Statistics - The statistics reports show useful information about the deliver of messages, such as average
delivery times, failure rates, etc.
  By Recipient - Messages are grouped by which recipient they were sent to
  By Date/Time - Messages are listed in the order they were sent out

  By Carrier - Messages are grouped by which carrier they were sent to

Lists - These reports print information about the carriers, recipients, and groups that are setup in NotePager
Pro.

  Recipient List - lists information about each recipient
  Group List - lists information about each group including (optionally) the members of each group
  Carrier List - lists information about each carrier including (optionally) the recipients that use each carrier
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4.36 Scheduled and Repeating Messages

Selecting the 'Options' button on the NotePager Pro's main screen will display a window where you can
schedule messages to be sent in the future, and messages that will be sent repeatedly.  To schedule a page

to be sent at a future date and time, fill in the 'Send Message When' fields.  To schedule a message to be sent
repeatedly, fill in the 'Send Message When' fields for when you want the first message to be sent.  Fill in the
'Resend Messages Every' fields to set the interval at which the message is resent.  Finally, fill in the 'Stop
Sending Message' fields to set the date and time for the message to stop being sent.

4.37 Scheduled Msgs

The 'Scheduled Messages' screen can be accessed by clicking on the 'Sched' label on NotePager Pro's main
screen, or by choosing 'Scheduled' from the 'View' menu.  This option allows you to make changes to a
message that has been scheduled for delivery, but hasn't been sent yet.

To edit a scheduled message, highlight a message entry on the 'Scheduled Messages' screen and then hit the
'Edit' button.  A message box will appear to let you know that this message will not be delivered until you hit the
'Send' button again (even if you don't make any changes).  the data from the message you selected will be filled
into the regular NotePager Pro screen.  Make the necessary changes and then resend the message by hitting

the 'Send' button.

4.38 Selected Recipients

The 'Selected Recipients' list box is displayed on the NotePager Pro's main screen.  It lists recipients (pagers)

that the next message will be sent to.  Recipients are added to the 'Selected Recipients' list by choosing them
from the 'Recipient List' box (see 'Recipient List' for more details).  You can remove a single recipient from this
list by simply clicking on the name of the recipient.  Clicking the 'Clear' button to the right of the 'Selected
Recipients' box, will clear all the recipients in the list.

4.39 Send

Clicking on the 'Send' button will send the message in the 'Message Text' area to all the recipients (pagers) in
the 'Selected Recipients' list.  The 'Send' button will animate to confirm your mouse click on the button.  The
'Message Text' and 'Selected Recipients' boxes are not cleared after clicking 'Send' (unless the 'Clear on Send'
option in the setup screen is enabled), enabling you to resend the message if needed.  To clear either of these

boxes, simple click the 'Clear' button to it's right.

4.40 Sender's Name

The 'Sender's Name' is sent at the beginning of each message, so the recipient knows who the message is
sent from.  A short name should be used because most pagers only display a limited number of characters on
their screens.  The 'Sender's Name' setting is located on the 'Tools' -> 'Settings' -> 'General' screen.

4.41 Sent

The 'Sent' status number on the main NotePager Pro screen shows how many messages have been
successfully sent by this workstation.  By clicking on the 'Sent' label, you can bring up the full 'Sent Messages'
log.  See 'Sent Messages' for more information on the log.
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4.42 Sent Messages

The 'Sent Messages' log shows information about messages that have been sent.  Information is only shown
for messages sent during the current session of the NotePager Pro.  This log displays whom the message

was sent to, when it was sent to the paging server, the current message status, and the beginning of the actual
message.  The 'Refresh' button will update the displayed information.  The 'Requeue' button will resend the
highlighted message.  The 'Copy' button allows you to copy this message information back into the main
NotePager Pro screen.  The 'Close' button will close the log screen.  The 'Sent Messages' log can be accessed

by choosing 'Sent' form the 'View' menu, or by clicking on the 'Sent' label on the NotePager Pro's main screen.

4.43 Spell Check

If the spell checking option is enabled on the general setup screen, messages can be checked for spelling
errors before they are sent.  The NotePager Pro uses Microsoft Word's spell checking utility that is included in
Word 97 or newer.  MS Word must be installed in order for NotePager Pro to be able to spell check messages.

A message can be checked by double-clicking anywhere in the 'Message Text' area, or by choosing 'Check
Spelling' from the 'Tools' menu.

4.44 Touch Tone Delivery

Touch messages are messages sent by calling a pager's phone number and sending a series of tones (like a
touch tone phone) as a message.  The tones are converted to their equivalent numbers and sent to the

recipient's pager.  Some paging carriers do not accept messages for numeric pagers via the regular TAP
(IXO/PET) protocol.  They only accept touch-tone numeric messages.  NotePager Pro  supports delivering
numeric messages in this manner, but it is not the preferred method.  This method of message delivery has no
provisions for error detection/correction or message confirmation.  It is sometimes known as 'blind dialing'

because there is no way to really know if the other end actually received the message.

How to setup a recipient for touch-tone messages:
First a 'Tone' carrier must be setup.  Only a single 'Tone' carrier may be needed to send message to all your

numeric pagers.  To make a carrier a 'Tone' carrier, choose 'Tone' as the 'Delivery Method' on the carrier setup
screen.  The default wait string ',,@' should work for most pagers.  If you need to use different wait string for
different pagers, you will need to create multiple 'Tone' carriers (one for each unique wait string needed).  The
wait string can be changed to support pagers with different input methods.

The comma (,) is used to pause (about one second)
The at sign (@) is used to wait for silence (about five seconds of silence)

The default wait string will dial the pager's number, pause for a couple of seconds, and then wait for a five
second period of silence (after the beeps or greeting message) and then send the message (touch tones).

To setup a recipient to use touch-tone delivery, simply choose the carrier you just setup as a 'Tone' carrier and

put the numeric pager's phone number in the 'Phone Num' field on the recipient setup screen.  If you have
setup several carriers with different wait strings, choose the carrier that will work with this pager's service
provider.  With this setup, NotePager Pro will dial the phone number setup in the recipient's 'Phone Num' field,
pause according to the commas or @ in the carrier's 'Wait String' field, and then send the touch-tone message.

Some paging providers use a common phone number for all numeric pagers.  The user must dial this number,
wait for a tone, dial their pager's ID number, wait for another message, and then type the numeric message.
This can be accomplished in NotePager Pro by setting the 'Tone' carrier's wait string to wait a predetermined

amount of time (using commas and or an @ symbol).  This would  be the wait time between sending the
pager's phone number and sending the actual touch-tone message.  On the recipient setup screen, in the
recipient's 'Phone Num' field, put the paging company's common phone number followed by a few commas or
an @ symbol, and then the pager's phone number.  This will give the following results:  The phone number will
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be dialed from the first part of the recipient's ID/PIN field,  NotePager Pro will pause according to the commas
or @ in the 'Phone Num' field, NotePager Pro will then send the second set of number in the recipient's 'Phone
Num' field and then pause according to the carrier's wait field.  NotePager Pro will then send the touch-tone

message.

4.45 Wizards

NotePager Pro has four Wizards that can assist you in setting up the program.  These wizards can be run at

any time by choosing 'Wizards' from the 'Tools' menu.

Setup Wizard - the Setup Wizard will walk you through some general settings that control the behavior of
NotePager Pro

Connection Wizard - the Connection Wizard helps you setup and test the connection you will be using to send
out messages (Modem or Internet)

Carrier Wizard - the Carrier Wizard walks you through the settings necessary to create a carrier in NotePager
Pro

Recipient Wizard - the Recipient Wizard walks you through the settings necessary to create a recipient in

NotePager Pro
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5 Troubleshooting

5.1 Installation

Problem:  Any number of different problems

Solution:  Be sure that there are no other programs running when you install NotePager Pro.  There may be

programs running even if you don't see them in your task bar.  Pressing <ctrl><alt><del> will bring up a list of
running programs in Windows 95, 98, or ME.  In Windows NT, 2000, or XP you can choose 'Task Manager' after
hitting <ctrl><alt><del> for similar information.  Stop any program that you believe is causing the conflict.
WARNING: this should only be done by an experienced user.  WARNING: Randomly ending tasks can lock up

your computer, lose data or worse.  Please consult with and experienced technician before killing any
processes.  A clean reboot can sometimes also help.  Holding down the shift key while windows is starting will
stop some programs from starting that automatically load at startup.  Try re-running the NotePager Net setup
program.

5.2 Init Strings

What is an init string?
Different modems can't necessarily talk to each other as set right out of the box.  Modems use many different
settings and protocols.  In order for two modems to communicate, they must agree on many things such as

speed, error correction, compression algorithms, etc...  By sending a modem an init string, you can control
some of these parameters.

What do I need to put in my init string?

In general, the modems used by paging carriers run at a speed from 300 to 2400 baud (1200 being the most
common).  They don't typically use any form of error correction or data compression protocols.  In many cases,
if your modem tries to use either of these protocols, your modem will be unable to communicate with the
paging terminal's modem.  In your init string you should include settings to lock you modem's baud rate to that

of your carrier's modem, disable error correction protocols, and disable data compression protocols.  In
addition NotePager Net would like your modem to issue English response codes (rather than numeric
response codes), and issue complete connection information.

Do all modems use the same init string?
No, many different modem manufacturers use their own set of modem commands.  Init strings may even be
different between models by the same manufacturer.

My init string works on one carrier but not the other.
You may need a different init string to connect to each carrier.  In general your init strings will be the same, but
not always.

What init string should I use?
There is no easy answer to this.  In general, if your modem is a 2400 baud model or slower (very old models)
you won't need an init string.  These older modems sometimes work best when communicating with the
paging terminals.  Anything faster (9600, 14.4, 28.8, 33.6, 56K, etc.), will probably require an init string.  Some of

the most common init strings are listed below.  If you have a less well known brand modem, you may need to
use the documentation include with you modem to create an init string.

Common Init Strings

AT&FQ0V1X4&D2   - Minimal settings.  Works with most 1200 and 2400 baud modems. Some modems use
&F0 rather than &F.  All '0' are zeros not oh's.
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AT&FQ0V1X4&D2N0S37=5   - Hard coded baud rate.  Works with many 14.4 and 28.8 modems.  The added
codes locks the connection baud rate to 1200 baud.  Use S37=3 for a 300 baud connection, and S37=6 for a
2400 baud connection.  Some modems use &F0 rather than &F.  All '0' are zeros not oh's.

AT&FQ0V1X4&D2N0S37=5\N0%C0   - No compression/error correction.  Works with many 14.4, 28.8 and 33.6
modems.  The added codes turn off data compression and error correction.  You can try using only one of the
two additional codes (\N0 or %C0) if you modem rejects using both.  Use S37=3 for a 300 baud connection,

and S37=6 for a 2400 baud connection.  Some modems use &F0 rather than &F.  All '0' are zeros not oh's.

AT&F0Q0V1X4&D2&B1&K0&M0&N2   - US Robotics (3Com) string.  Works with most US Robotics/3Com 33.6
and 56K modems (and some others too).  Use &N1 (instead of &N2) for a 300 baud connection, or &N3 for a

2400 baud connection.

AT&FQ0V1X4&D2N0+MS=B103  - This string has been found to work with some of the newer winmodems.  Set
the baud rate to 300 when using this string.

Note: all '0' characters in the init strings are zeros not oh's

***More init strings may be available on our web site: www.notepager.net

5.3 Connecting to Carriers Using GSMAT

5.3.1 Make sure you are communicating with phone or modem

The first step is to make sure your computer is talking with your mobile phone or wireless modem.

Testing with HyperTerminal:
HyperTerminal is a terminal emulation program that comes with Windows.  It can be used to test
communications with your phone or modem.  You should perform this test even if other applications work
correctly with your phone or modem.  NotePager Pro talks to your phone or modem by addressing its serial

port.  Other applications may bypass the port settings and work even if your port settings are incorrect.
HyperTerminal can be found under the 'Accessories' option on your Windows start menu.  Depending on the
version of Windows you are running, it may be under a group below 'Accessories' called 'Communications'.

If HyperTerminal is not installed, you can install it by choosing 'Add/Remove Programs' from within the
Windows control panel.  Choose the tab labeled 'Windows Setup'.  HyperTerminal can be found under the
'Communications' group.

After choosing HyperTerminal from accessories, invoke the HyperTerminal program by either choosing the
'Hyperterm' icon from the group window, or by choosing 'HyperTerminal' from the next group of programs on the
Windows start menu.  If its the first time you have run HyperTerminal, you may be asked to enter your area
code.  If so, do it now.  The next screen will ask you for a name for your new connection.  The name is not

important.  Use something like 'test'.  Hit 'OK'. On the next screen, among other things, you are asked for what
modem to use ('Connect Using').  Do not choose the name of your modem.  Instead, choose the name of the
com port you entered into NotePager Pro (i.e. 'Direct to Com2' or 'Com2').  Hit 'OK'.  The next screen will ask you
for 'Port Settings'.  Use the settings that were used when the carrier in question was setup in NotePager Pro.

Choose 'None' for flow control.

You should now get a somewhat blank HyperTerminal window with a blinking cursor.  If you don't, then your
phone's or modem's com port settings are incorrect, your hardware is not setup correctly, or some other

program is using the device.  Otherwise, you should now be able to type 'AT <cr>' (don't type the ' symbols, and
,<cr> stands for the carriage return or enter key).  The letters 'AT' may or may not appear on the terminal
window.  Don't be alarmed if they don't.  However, in either case, your modem should respond with and 'OK'.  If
you don't receive an 'OK' then your serial port or modem is not operating correctly and must be fixed before

NotePager Pro can use them.  If you do get an 'OK', then continue to the next step.
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5.3.2 Test your phone or modem for GSMAT support

Not all mobile phones and wireless modems support the GSMAT protocol.  Here is how you can test if your
device supports it.

If you have not already completed the first step in this section labeled 'Make sure you are communicating with

phone or modem', do it now.

After successfully getting an 'OK' response back from the previous step, try typing 'AT+CMGS=?<cr>' (don't
include the quotes, and <cr> stands for your Enter key).  If you don't get an 'OK' response back, then your phone

or modem does not support the GSMAT protocol as defined in the GSM 07.05 standard.

5.3.3 Other notes for GSMAT

When sending messages with the GSMAT protocol, you need to use a valid phone number for the sender of the
message.  You can set the sender by going to 'Tools' -> 'Settings' -> 'General'.  Use a valid mobile phone
number (typically the phone number for your mobile phone or wireless modem that you are using to send the

messages).

NotePager Pro supports the GSM AT Commandset as defined in the GSM 7.05 specification

5.4 Connecting to Carriers Using SMTP

5.4.1 Test connection to a known host

The first step is to verify that you can connect to a know SMTP server from your computer.  If you have NotePager

Pro setup to deliver messages directly to the destination mail server, you should be able to successfully
following these steps.

1. Get to a DOS or Command prompt

1a. In Windows 95, 98, or ME hit 'Start' -> 'Programs' -> 'MS-Dos Prompt'
1b. In Windows NT hit 'Start' -> 'Programs' -> 'Command Prompt'
1c. In Windows 2000, XP hit 'Start' -> 'Programs' -> 'Accessories' -> 'Command Prompt'

2. Type 'telnet notepage.net 25 <CR>' (don't include the quotes, <CR> is the Enter key, there is a space before
'notepage.net' and before '25')

3a. In Windows 95, 98, ME, and NT you will get a Telnet window

3b. in Windows 2000 and XP the telnet session will run in the DOS window

4. You should receive a line of data that begins with the number 220.
4a. If you do, then NotePager Pro can make outbound connections using SMTP

4b. If you don't, then your computer can't make direct outbound connections using SMTP.  This is usually
because either you aren't connected to the Internet, or you are behind some sort of firewall that is blocking
outbound sessions on port 25.  In either case, try setting up NotePager Pro to deliver messages through a
local email server (SMTP relay server).

5.4.2 Test connection to local mail server

If you are running NotePager Pro on a computer that is behind a firewall, you may not be able to deliver SMTP
messages directly to their destination.  Instead, you may be able to 'relay' the messages through an existing
mail server on your local network.  Here are steps to take to verify that your computer can communicate with

your local SMTP (email) server.

1. Get to a DOS or Command prompt
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1a. In Windows 95, 98, or ME hit 'Start' -> 'Programs' -> 'MS-Dos Prompt'
1b. In Windows NT hit 'Start' -> 'Programs' -> 'Command Prompt'
1c. In Windows 2000, XP hit 'Start' -> 'Programs' -> 'Accessories' -> 'Command Prompt'

2. Type '<local mail server> 25 <CR>' (don't include the quotes, substitute <your mail server> with the name or
IP address of your local SMTP (email) server, <CR> is the Enter key, there is a space before '<local mail
server>' and before '25')

3a. In Windows 95, 98, ME, and NT you will get a Telnet window
3b. in Windows 2000 and XP the telnet session will run in the DOS window

4. You should receive a line of data that begins with the number 220.
4a. If you do, then NotePager Pro can make a connection to your local SMTP (email) server.  The next step
would be to setup NotePager Pro to send some test messages through this local server and see if it will relay
them for you.

4b. If you don't, then your computer can't make a connection to your local SMTP (email) server.  You should
contact your network admin and verify your computer's settings.

5.4.3 Other notes for SMTP

When using the SMTP protocol, the 'Sender' that you setup on NotePager Pro's General Settings screen, will be
used as a return address for the messages sent out.

Some carriers verify the validity of the return address, so make sure the 'Sender' field is a valid email address.

If you don't include the domain name part in the 'Sender' field, NotePager Pro will automatically add the 'Local
Domain' to it (you set this on the SMTP carrier's settings screen).

SMTP is usually the last choice of protocols for wireless messaging.  It does not have the advantage of positive
confirmation of reception by the carrier, and there can often be delays in message delivery.  This is a protocol
limitation, not a NotePager Pro limitation.

5.5 Connecting to Carriers Using SNPP

5.5.1 Test connection to a known host

The first step is to verify that you can connect to a know SNPP server from your computer.

1. Get to a DOS or Command prompt
1a. In Windows 95, 98, or ME hit 'Start' -> 'Programs' -> 'MS-Dos Prompt'

1b. In Windows NT hit 'Start' -> 'Programs' -> 'Command Prompt'
1c. In Windows 2000, XP hit 'Start' -> 'Programs' -> 'Accessories' -> 'Command Prompt'

2. Type 'telnet notepage.com 444 <CR>' (don't include the quotes, <CR> is the Enter key, there is a space

before 'notepage.com' and before '444')

3a. In Windows 95, 98, ME, and NT you will get a Telnet window
3b. in Windows 2000 and XP the telnet session will run in the DOS window

4. You should receive a line of data that says: 220 NotePage 444 Responder Ready
4a. If you do, then NotePager Pro can make outbound connections using SNPP.  You should next try this same
test, but use your carrier's host address.

4b. If you don't, then your computer can't make direct outbound connections using SNPP.  This is usually
because either you aren't connected to the Internet, or you are behind some sort of firewall that is blocking
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outbound sessions on port 444.  You should contact your network admin if you can not make this connection.

5.6 Connecting to Carriers Using TAP

5.6.1 Make sure your modem is operating correctly

HyperTerminal is a terminal emulation program that comes with Windows.  It can be used to test
communications with your modem.  You should perform this test even if other applications work correctly with
your modem.  NotePager Pro talks to your modem by addressing its serial port.  Other applications may

bypass the port settings and work even if your port settings are incorrect.  HyperTerminal can be found under
the 'Accessories' option on your Windows start menu.  Depending on the version of Windows you are running, it
may be under a group below 'Accessories' called 'Communications'.

If HyperTerminal is not installed, you can install it by choosing 'Add/Remove Programs' from within the
Windows control panel.  Choose the tab labeled 'Windows Setup'.  HyperTerminal can be found under the
'Communications' group.

After choosing HyperTerminal from accessories, invoke the HyperTerminal program by either choosing the
'Hyperterm' icon from the group window, or by choosing 'HyperTerminal' from the next group of programs on the
Windows start menu.  If its the first time you have run HyperTerminal, you may be asked to enter your area
code.  If so, do it now.  The next screen will ask you for a name for your new connection.  The name is not

important.  Use something like 'test'.  Hit 'OK'. On the next screen, among other things, you are asked for what
modem to use ('Connect Using').  Do not choose the name of your modem.  Instead, choose the name of the
com port you entered into NotePager Pro (i.e. 'Direct to Com2' or 'Com2').  Hit 'OK'.  The next screen will ask you
for 'Port Settings'.  Use the settings that were used when the carrier in question was setup in NotePager Pro.

Choose 'None' for flow control.

You should now get a somewhat blank HyperTerminal window with a blinking cursor.  If you don't, then your
modem or com port settings are incorrect, your hardware is not setup correctly, or some other program is using

the modem.  Otherwise, you should now be able to type 'AT <cr>' (don't type the ' symbols, and ,<cr> stands for
the carriage return or enter key).  The letters 'AT' may or may not appear on the terminal window.  Don't be
alarmed if they don't.  However, in either case, your modem should respond with and 'OK'.  If you don't receive
an 'OK' then your serial port or modem is not operating correctly and must be fixed before NotePager Pro can

use them.  If you do get an 'OK', then continue to the next step.

5.6.2 Make sure you have a dial tone

If you can hear NotePager Pro pick up the phone and get a dial tone before it dials, skip to the next step.  If you

don't currently have HyperTerminal running, follow the steps in the above section so that HyperTerminal is
running and responds with an 'OK' when you type 'AT<cr>'.

Type 'ATDT<cr>'. You should hear a dial tone.  Some modems may have their speakers turned off.  That is ok.

After a little while you should get one of two messages on the HyperTerminal screen: 'No Carrier' or 'No
Dialtone'.  'No Carrier' is a good response, you have dialtone.  'No Dialtone' … well that one needs no further
explanation.

5.6.3 Make sure you are connecting to a modem

Using a regular phone, dial the phone number you entered as the carrier's phone number in NotePager Pro.
Now is a good time to note that many modem lines may have different requirements to get an outside line than
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a phone system does (i.e. just because you dial a '9' to get an outside line on your phone system, you may not
need one on your modem line, or vice versa).  After dialing the number, you should hear it ring and then pickup.
Next you should hear a long high-pitched tone (at least 10 seconds and steady).  If you don't, you have the

wrong number for your paging service provider's terminal.  Often times if you are given the wrong number, you
will hear a voice message or a beep-beep-beep.

5.6.4 Make sure you are connecting to a paging terminal

If you have gotten this far, you are at least calling a modem.  Next, we have to be sure we can connect to the
modem on the other end, and that it is a paging terminal that supports the TAP/IXO protocol.

Follow the steps in the first section so that you are running HyperTerminal and are getting an 'OK' response to

typing 'AT<cr>'.  Now type 'ATDT<phone number><cr>' where <phone number> should  be replaced with the
phone number you entered into the carrier in NotePager Pro.  After the modem dials it should connect to the
modem at the other end and you should get a 'CONNECT' message on the HyperTerminal screen.  If you can't
connect, either the phone number is wrong (there really isn't a paging terminal at the other end) or you need to

use an init string to make a connection to it.  You will find some common init strings in the 'Init Strings' section
of this manual or on our website (www.notepager.com).  To try an init string, simply type it into HyperTerminal
and hit the enter key.  If the string is accepted, you should get an 'OK' back.  If the string is invalid for your
modem, you will get and 'ERROR' response.  After entering a valid init string, try connecting to the carrier again

('ATDT<phone number><cr>').  If HyperTerminal can't connect to the carrier, NotePager Pro won't be able to
either.

After you receive a 'CONNECT' message, you should receive an 'ID=' message within about five seconds.  If

not, try hitting the enter key about every three seconds.  After retrying the carrier a couple of times, if you still
don't get and 'ID=' prompt, either you don't have a proper init string, your communications settings are incorrect
(baud, data bits, etc.), or you aren't connecting to a paging terminal.  If you do receive the 'ID=' prompt, quit out of
HyperTerminal, start NotePager Net, and go to the next step.

Note:  If you used a different init string here to get this far, be sure to update the carrier's init string in NotePager
Pro before continuing.

5.6.5 Check the Dialer Log

In NotePager Pro, select the 'Setup' from the 'File' menu.  Make sure that 'Detailed Log' is checked.  Apply your

changes.  You can view the dialer's log file by selecting the 'Dialer Log' item from the 'View' menu.  Next, send a
test message and then review the dialer log.  Here are failure messages for the dialers and their possible
causes:

Unable to send init string - the dialer init was sent to the modem, but not accepted.  Verify the syntax of the init
string, or try a new one.

Unable to connect to carrier  - the dialer didn't receive a 'CONNECT' message from the modem.  This is

usually caused by a wrong phone number, incorrect modem settings, or improper init string.

Checksum error  - your message was transmitted to the carrier, but the data received didn't match the data you
sent.  This can be caused by a bad connection or improper init string.

Bad message content - your message was received by the carrier without any errors.  However, the carrier
rejected the message due to invalid data in it.  This is almost always caused by an incorrect ID/PIN number, or
by sending a message that is longer than what the carrier will accept in a single message (try lowering the

'maxchars' setting for the carrier).

Disconnect requested by carrier - this message could mean a number of different things.  It is sometimes
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simply given because the carrier has a limit to the number of messages it will accept in a single session, and
wants you to hang up.  In most other cases, the terminal has detected a condition which prohibits it from
continuing to accept messages, and wants to terminate the session.

No response from carrier  - somewhere in the middle of transmitting messages, contact was lost with the
carrier.  This is usually caused by a bad phone connection, or the need for a better init string.

Message retry limit reached  - the message has been retried a number of times without being sent
successfully.  The message at this point is marked as bad, and not retried again.  Please check the error
message previous to this one in the log for causes.

Carrier retry limit reached  - This means that a specific carrier has been unable to be reached after being
retried for a number of times.  Check the log for failure messages prior to this one for more information on how
the connection failed.  This message is usually due to an outage of service at the carrier or a
modem/phoneline/hardware failure.  All pending messages currently queued for this carrier are marked as

bad, so as not to delay the delivery of message to other carriers that are still accessible.

5.6.6 I have a 56K modem and I am unable to connect to a carrier.

Many new 56K modems are 'voice' modems, which means that they support features such as speakerphone,
voice mail, sound recording, etc.  In order for these features to be supported, the modem locks itself in a high-

speed connection mode which can't be over-ridden by using init strings.  To disable the voice capabilities of the
modem follow these instructions:

1. From the Windows start menu choose: 'Start' > 'Settings' > 'Control Panel'

2. From the control panel double-click on the icon labeled 'System'.

3. On the 'System Properties' screen click on the tab labeled 'Device Manager'

4. Find the entry called 'Sound, video and game controllers' (if there isn't one,
you don't have a voice modem)

5. Click on the '+' sign next to the entry

6. Select the entry under 'Sound, video and game controllers' called: 'Wave device for voice modem' (if there
isn't one there, you don't have a voice modem).

7. Click on the 'Properties' button.

8. The properties screen for the device will appear.  Check the box labeled 'Disable in this hardware profile'.

9. Click 'OK' and then 'OK' again.

10. Restart your computer.

5.7 Sending Messages Using TONE

5.7.1 Notes for TONE

Some carriers will only accept touch tones (dtmf) to send messages to their numeric pagers.  You should
always first try to use TAP with numeric pagers, as it is a superior delivery method.

NotePager Pro uses a 'blind dialer' to send numeric touch tone messages.  Its goal is basically to dial the
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phone number of the pager, get past the 'beep-beep-beep' or voice recording, and then send the touch tone
equivalent of the numeric message.

Unlike other protocols, using TONE may take a little experimenting to work reliably.  Try different combinations
of commas and at-symbols in the 'Wait String' and phone number.  On most modems a comma (,)pauses for
2-3 seconds, and the at-symbol (@) waits for 4-5 seconds of silence.

5.8 Connecting to Carriers Using UCP

5.8.1 Make sure your modem is operating correctly

HyperTerminal is a terminal emulation program that comes with Windows.  It can be used to test

communications with your modem.  You should perform this test even if other applications work correctly with
your modem.  NotePager Pro talks to your modem by addressing its serial port.  Other applications may
bypass the port settings and work even if your port settings are incorrect.  HyperTerminal can be found under
the 'Accessories' option on your Windows start menu.  Depending on the version of Windows you are running, it

may be under a group below 'Accessories' called 'Communications'.

If HyperTerminal is not installed, you can install it by choosing 'Add/Remove Programs' from within the
Windows control panel.  Choose the tab labeled 'Windows Setup'.  HyperTerminal can be found under the

'Communications' group.

After choosing HyperTerminal from accessories, invoke the HyperTerminal program by either choosing the
'Hyperterm' icon from the group window, or by choosing 'HyperTerminal' from the next group of programs on the

Windows start menu.  If its the first time you have run HyperTerminal, you may be asked to enter your area
code.  If so, do it now.  The next screen will ask you for a name for your new connection.  The name is not
important.  Use something like 'test'.  Hit 'OK'. On the next screen, among other things, you are asked for what
modem to use ('Connect Using').  Do not choose the name of your modem.  Instead, choose the name of the

com port you entered into NotePager Pro (i.e. 'Direct to Com2' or 'Com2').  Hit 'OK'.  The next screen will ask you
for 'Port Settings'.  Use the settings that were used when the carrier in question was setup in NotePager Pro.
Choose 'None' for flow control.

You should now get a somewhat blank HyperTerminal window with a blinking cursor.  If you don't, then your
modem or com port settings are incorrect, your hardware is not setup correctly, or some other program is using
the modem.  Otherwise, you should now be able to type 'AT <cr>' (don't type the ' symbols, and ,<cr> stands for
the carriage return or enter key).  The letters 'AT' may or may not appear on the terminal window.  Don't be

alarmed if they don't.  However, in either case, your modem should respond with and 'OK'.  If you don't receive
an 'OK' then your serial port or modem is not operating correctly and must be fixed before NotePager Pro can
use them.  If you do get an 'OK', then continue to the next step.

5.8.2 Make sure you have a dial tone

If you can hear NotePager Pro pick up the phone and get a dial tone before it dials, skip to the next step.  If you
don't currently have HyperTerminal running, follow the steps in the above section so that HyperTerminal is

running and responds with an 'OK' when you type 'AT<cr>'.

Type 'ATDT<cr>'. You should hear a dial tone.  Some modems may have their speakers turned off.  That is ok.
After a little while you should get one of two messages on the HyperTerminal screen: 'No Carrier' or 'No

Dialtone'.  'No Carrier' is a good response, you have dialtone.  'No Dialtone' … well that one needs no further
explanation.
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5.8.3 Make sure you are connecting to a modem

Using a regular phone, dial the phone number you entered as the carrier's phone number in NotePager Pro.
Now is a good time to note that many modem lines may have different requirements to get an outside line than
a phone system does (i.e. just because you dial a '9' to get an outside line on your phone system, you may not
need one on your modem line, or vice versa).  After dialing the number, you should hear it ring and then pickup.

Next you should hear a long high-pitched tone (at least 10 seconds and steady).  If you don't, you have the
wrong number for your paging service provider's terminal.  Often times if you are given the wrong number, you
will hear a voice message or a beep-beep-beep.

5.8.4 I have a 56K modem and I am unable to connect

Many new 56K modems are 'voice' modems, which means that they support features such as speakerphone,
voice mail, sound recording, etc.  In order for these features to be supported, the modem locks itself in a high-

speed connection mode which can't be over-ridden by using init strings.  To disable the voice capabilities of the
modem follow these instructions:

1. From the Windows start menu choose: 'Start' > 'Settings' > 'Control Panel'

2. From the control panel double-click on the icon labeled 'System'.

3. On the 'System Properties' screen click on the tab labeled 'Device Manager'

4. Find the entry called 'Sound, video and game controllers' (if there isn't one,
you don't have a voice modem)

5. Click on the '+' sign next to the entry

6. Select the entry under 'Sound, video and game controllers' called: 'Wave device for voice modem' (if there
isn't one there, you don't have a voice modem).

7. Click on the 'Properties' button.

8. The properties screen for the device will appear.  Check the box labeled 'Disable in this hardware profile'.

9. Click 'OK' and then 'OK' again.

10. Restart your computer.

5.8.5 Other notes for UCP

The UCP (Universal Computer Protocol) is used mostly in non-English speaking countries in Europe.

Usually the 'Sender' field (setup on the General Settings screen) needs to be a valid phone number, for the
carrier to accept your message.
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5.9 Connecting to Carriers Using WCTP

5.9.1 Test connection to a known host

This test is easy.  If you can get to any site on the Internet (i.e. http://www.notepager.com), then your Internet
connectivity is good.

The next step is to test connectivity to your carrier's WCTP gateway.

1. In your web browser (i.e. Internet Explorer, Netscape Navigator, etc.), type the address of your carrier's
gateway (i.e. http://wctp.arch.com/wctp, or http://wctp.airtouch.com/wctp, etc.)

2. What you get back in your browser will vary depending on what browser you are using, and what WCTP
gateway you are connecting to.  What you shouldn't get back is an error saying that you cannot find or connect to
the website.

3. Typically after connecting, if you view the document source in your browser (this is usually accessed from
your browser's menu, but can be in different places depending on your browser, and browser version), you will
see some information relating to WCTP.

5.9.2 Other notes for WCTP

WCTP is a descent Internet based messaging protocol, but not as widely accepted as SNPP.  The advantage

of WCTP is that it will typically work through a firewall or proxy server.  If your carrier accepts both WCTP and
SNPP, but you are behind a firewall, or your web-browser uses a proxy server, then WCTP may be a better
choice.

5.10 Misc

5.10.1 I receive the error 'Unable to access modem'

This message is given if NotePager Pro is unable to talk to your modem.  Check the port you have set

NotePager Pro is set to use in its setup screen.  If you have an external modem, make sure it is connected and
turned on. There may be another program running on your system that is using the modem. For example, you
will get this error if you have a fax program running in the background waiting to receive faxes, or you may have
a remote control program such as PC Anywhere running in the background waiting for a call. NotePager Pro

requires exclusive use of the modem. For more information, please refer to the section 'Connecting to a carrier'
in the 'Troubleshooting' chapter of the NotePager Pro help file.

5.10.2 My pager keeps receiving garbled messages, why?

Garbled messages are caused by a low battery, poor reception (inside some buildings or in fringe areas), or a

defective paging unit.

5.10.3 NotePager Pro says the message was sent, but I never received it on my
pager, why?

If NotePager Pro indicates that the message has been sent successfully, it means that the paging terminal has
confirmed receipt of the message. If the message is not received, you may be out of your paging coverage area
(or in a fringe area), your account may be incorrectly set up by the carrier, or you may have an incorrect ID/PIN

number.
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